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1 .  BASICS

Matlab Environment

L A U N C H  M A T L A B
To start Matlab in Mac OS X, open the Applications folder and click on the MATLAB icon.

M A T L A B  C O M M A N D  W I N D O W
Once Matlab is launched, you should see a new window with many panels. The most important 
part of this window is the large white area called ‘Command Window’ where you can dialog with 
Matlab by writing some little commands.

Installing MIRtoolbox
If MIRtoolbox is already installed (cf. subsection below “Check the Installation”), you don’t need 
to read this section.

Download MIRtoolbox at this address:

http://www.jyu.fi/hum/laitokset/musiikki/en/research/coe/materials/mirtoolbox

You can save the unzipped folder wherever you like (on the desktop, or in your documents fol-
der, etc.).

Add MIRtoolbox in the MATLAB path:

1. Open the Set Path window:

• In Matlab 2012b or more recent: In the toolstrip on the top of Matlab, on the Home tab, 
in the Environment section, click “Set Path”.

• In Matlab 2012a or older: In the “File” menu, select “Set Path...”.

2. In the new “Set Path” window, click on the second button “Add with Subfolders...”

3. In the file browser, select the folder you downloaded and unzipped (it should be called 
MIRToolbox1.4.something) and click “Open”. You should see several new lines highlighted 
in blue in the “MATLAB search path” list in the “Set Path” window. These are the folder ad-
dresses of the content of the toolbox.
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4. To avoid performing the operations 1-3 every time you launch Matlab, save MATLAB path 
by clicking on the “Save” button. You can then click on the “Close” button.

C H E C K  T H E  I N S T A L L A T I O N
Check that MIRtoolbox is properly installed by typing

ver mirtoolbox

in the MATLAB Command Window. You should see something like:

------------------------------------------------------------------------------------- 

MATLAB Version 7.x.x.xxx (R20xx) 

MATLAB License Number: xxxxx 

Operating System: ......  

Java VM Version: ..... 

------------------------------------------------------------------------------------- 

MIRtoolbox                                            Version 1.x.x 

If you see that last line, that means that MIRtoolbox is properly installed.

mirplay: Playing an audio file

E X A M P L E  A U D I O  F I L E S
MIRtoolbox includes a set of musical examples that can be used to test the software. One of 
those files is a short excerpt of a piano ragtime, and is named ragtime.wav. To simply play that 
audio file, just write the following command in Matlab Command Window:

mirplay('ragtime.wav')

and then press enter to execute that command.

Y O U R  A U D I O  F I L E S
Now let’s try to load and play one of your own audio file. The file should be in WAV, MP3 or 
AU format, and should be stored in a folder accessible to your computer (for instance, your 
‘Desktop’ folder). First of all, you need to tell Matlab that the Current Directory you want to 
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consider now is that particular folder where your file is located. To set the Current Directory, 
just click on the ‘Browse for folder’ icon (‘...’ button next to the Current Directory field in the 
main Matlab toolbar.

In Matlab 2012a or older:

�

In Matlab 2012b or more recent:

�

This opens a file browser where you can select that particular folder, and click ‘Open’.

Once you have selected that folder, you should now see the content of that folder on the 
‘Command Directory’ panel on the left of the Matlab window. In particular, the file you want to 
analyze should be indicated in that panel. Now you can simply play that file as before. If for 
instance your file is called myfile.wav, then just write the following command:

mirplay('myfile.wav')

P L A Y I N G  A  F O L D E R  O F  F I L E S
You can also play a complete folder by writing the following command:

mirplay('Folder')

H O W  T O  A B O R T  A  P R O C E S S
If some particular process you have launched in Matlab takes too much time, you can abort it 
at any point. For instance, if you asked to play all the audio files of a folder, you can stop that 
playlist by pressing on both keys ‘ctrl’ and ‘c’ altogether. It might sometime takes some time to 
abort. If Matlab still does not react, try pressing this key combination several times.

miraudio: Audio waveform
MIRtoolbox offers a set of tools for the analysis of audio recordings, of music in particular. The 
simplest representation that can be obtained from an audio recording is the waveform repre-
sentation of the audio signal.

To display the audio waveform of the ragtime.wav file, just write the following:
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miraudio(‘ragtime.wav')

This opens a new Figure window that contains the graphical representation of the audio wave-
form. 

S A V I N G  F I G U R E S  A S  I M A G E S
You can save that image by selecting ‘Save’ in the ‘File’ menu on the top of the Figure window. 
Matlab can save in various image format, that you can see in the File Format list. If for instance 
you want to save the image for further use in Microsoft Office, you can save it for instance 
using a file name with the PNG extension, such as myimage.png.

Y O U R  A U D I O  F I L E
To display the audio waveform of a file called myfile.wav located in the Current Directory, just 
write the following:

miraudio('myfile.wav')

A N A L Y Z I N G  A  F O L D E R  O F  F I L E S
To display the audio waveforms of all the audio files located in the Current Directory, just 
write the following:

miraudio('Folder')

E X T R A C T I N G  A  P A R T
You can focus on one particular part of your audio file. If for instance, you want to see only the 
excerpt starting at t = 20 seconds and ending at t = 30 seconds, just write the following:

miraudio('myfile.wav', 'Extract', 20, 30)

P L A Y I N G  A N  E X C E R P T
You can store your excerpt in a variable – let’s call it a, for instance:

a = miraudio('myfile.wav', 'Extract', 20, 30);

TIP: If you don’t want to see the graphical output of this command, just add ‘;’ at the end of 
the line, as in the previous example. 

In this way you can then play the result (i.e., that particular excerpt) by simply writing:
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mirplay(a)

mirrms: Global energy

G L O B A L  R E P R E S E N T A T I O N
One very simple description of sound is its global energy computed using an operator called 
RMS (Root Mean Square). To get the global energy for the ragtime example, just write the fol-
lowing:

mirrms(‘ragtime.wav')

This first representation simply gives one number indicating the amount of energy for the 
whole piece of music. You should get this text in the Command Window:

The RMS energy related to file ragtime is 0.017932  

This could be used to compare different audio files, for instance.

mirrms('Folder')

T E M P O R A L  E V O L U T I O N
Alternatively, we can also see the evolution over time of this energy, by using the ‘Frame’ key-
word:

mirrms(‘ragtime.wav', 'Frame')

P L A Y  T H E  R E S U L T
You can also visualise the curve while playing the audio at the same time, using the new inter-
face developed by Pasi Saari.

r = mirrms('ragtime', 'Frame')

mirplayer(r)

In the new ‘MIRplayer’ window, you have under the left column ‘SELECT FEATURES AND 
PEAKS’ the name of the feature we just computed: ‘RMS energy’. Click on the triangle on its 
left to unroll the list of colors, and click on the first black icon. You should see the RMS curve 
appearing on the graph. Now click on the play button...
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A N A L Y Z I N G  A N  E X C E R P T
You can get the global energy of the excerpt you have selected:

a = miraudio('myfile.wav', 'Extract', 20, 30)

mirrms(a)

And similarly, for the temporal evolution of energy of that excerpt:

mirrms(a, 'Frame') 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2 .  SPECTRAL ANALYSIS

mirspectrum: Spectral decomposition

G L O B A L  R E P R E S E N T A T I O N
One common representation of sound is by displaying the repartition of energy along the dif-
ferent frequencies. To get this spectral representation for the ragtime example, just write the 
following:

mirspectrum(‘ragtime.wav')

This first representation simply gives the global repartition for the whole piece of music. You 
can use the magnifier button in the toolbar to zoom in in the picture, or alternatively you can 
select a particular frequency region, for instance below 3000 Hz:

mirspectrum('ragtime.wav', 'Max', 3000)

T E M P O R A L  E V O L U T I O N
Alternatively, we can also see the evolution over time of this spectral representation, by using 
the ‘Frame’ keyword:

mirspectrum('ragtime.wav', 'Frame')

Now the different frequencies are represented on the vertical axis, the horizontal axis corres-
ponds to the temporal evolution of the music. Similarly, you can zoom in, or select a frequency 
region, for instance:

mirspectrum('ragtime.wav', 'Frame', 'Max', 3000)

A N A L Y Z I N G  A N  E X C E R P T
You can get the spectral representation of the excerpt you have selected:

a = miraudio('myfile.wav', 'Extract', 20, 30)

mirspectrum(a)

And similarly, for the temporal spectral evolution of that excerpt:
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mirspectrum(a, 'Frame')

S P E C T R A L  F L U X
You can compare the spectrum between each successive frame, that gives a temporal curve, 
called spectral flux:

s = mirspectrum('ragtime.wav', 'Frame')

mirflux(s)

The peaks in this curve shows where there are important changes in the spectrum.

P L A Y  T H E  R E S U L T
You can also visualise the curve while playing the audio at the same time:

f = mirflux(s)

mirplayer(f)

mirbrightness: How bright is the sound?
b = mirbrightness('myfile.wav', 'Frame')

mirplayer(b)

The brightness curve shows the evolution of brightness throughout the piece of music. High 
values indicates moments in the music where most of the sound energy is on the high-frequen-
cy register, whereas low values indicates moments where most of the sound energy is on the 
low-frequency register.

You can also compute the curve for a given excerpt of your audio file, for instance between t = 
20 seconds and t = 30 seconds:

a = miraudio('myfile.wav', 'Extract', 20, 30)

mirbrightness(a, 'Frame')

You can also compute a global brightness value for each audio files in your Current Directory. 
Write then:
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b = mirbrightness('Folder')

So that you can now play the audio files in increasing order of brightness:

mirplay('Folder', 'Increasing', b)

mircentroid: Spectral centroid
c = mircentroid('ragtime.wav', 'Frame')

mirplayer(c)

The spectral centroid curve is quite similar to the brightness curve. It shows, for each successive 
instant of the music, around which frequencies the sound energy is centered. High values indi-
cates moments in the music where most of the sound energy is on the high-frequency register, 
whereas low values indicates moments where most of the sound energy is on the low-frequency 
register.

You can also compute the curve for a given excerpt of your audio file, for instance between t = 
20 seconds and t = 30 seconds:

a = miraudio('myfile.wav', 'Extract', 20, 30)

mircentroid(a, 'Frame')

You can also compute a global spectral centroid value for each audio files in your Current Di-
rectory:

c = mircentroid('Folder')

So that you can now play the audio files in increasing order of spectral centroid:

mirplay('Folder', 'Increasing', c)

mirroughness: Sensory dissonance
r = mirroughness('ragtime.wav')

mirplayer(r)
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The roughness curve shows the amount of sensory dissonance at each successive moments 
throughout the piece of music. This sensory dissonance corresponds to the “beating” pheno-
menon when several sound are heard with nearly the same frequency, but with just a few Hz of 
difference. When roughness is high, the sounds feels more harsh, containing more strange os-
cillations. 

You can also compute the curve for a given excerpt of your audio file, for instance between t = 
20 seconds and t = 30 seconds:

a = miraudio('myfile.wav', 'Extract', 20, 30)

mirroughness(a)

You can also compute a roughness curve for each audio files in your Current Directory:

r = mirroughness('Folder')

Then get the average of roughness for each separate file, so that we have now one global value 
for each file:

m = mirmean(r)

So that you can now play the audio files in increasing order of roughness:

mirplay('Folder', 'Increasing', m)
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3 .  TEMPO
mirtempo: Tempo estimation
You can get a tentative estimation of the tempo of a given recording by writing for instance:

mirtempo('myfile.wav')

A temporal evolution of tempo, or tempo curve, can also be obtained:

t = mirtempo('myfile.wav', 'Frame')

mirplayer(t)

You can also compute a global tempo value for each audio files in your Current Directory. 
Write then:

t = mirtempo('Folder')

So that you can now play the audio files in increasing order of tempo:

mirplay('Folder', 'Increasing', t)

mirpulseclarity: Clarity of the pulsation
It is possible to get an estimation of the strength of the beat – i.e., the relative importance of 
the regular pulsation – by using the command:

mirpulseclarity('myfile.wav')

p = mirpulseclarity('myfile.wav', 'Frame')

mirplayer(p)

You can also compute a global pulse clarity value for each audio files in your Current Directory:

p = mirpulseclarity('Folder')

So that you can now play the audio files in increasing order of pulse clarity:

mirplay('Folder', 'Increasing', p)  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4 .  TRANSCRIPTION

mironsets: Detection of the successive notes
In order to detect the notes that are contained in a recording, we first need to find where in 
time the notes starts. For that, a onset curve can be computed like this:

mironsets('myfile.wav')

The peaks of the curve indicates the point where the energy is the highest. We can suppose 
that these peaks corresponds the successive notes in the music. These peaks are highlighted 
with red circles.

Before the peak of each note, there is the attack phase where the energy progressively increase. 
We can see the attack phase of each note:

mironsets('myfile.wav', 'Attacks')

Similarly, we can also see the release phase, where the energy of the note progressively decreases 
after the peak:

mironsets('myfile.wav', 'Attacks', 'Releases')

mirsegment: Segmentation
Then you can segment the audio files at the position of those onsets, by writing:

o = mironsets('myfile.wav', 'Attacks', 'Releases')

s = mirsegment('myfile.wav', o)

Then play the result of this segmentation:

mirplay(s)

mirattackslope: Attack of notes
These attack phases show how each note is attacked: if a note has a steep attack (short attack 
but with a very fast increase), it sounds more aggressive than if a note has a more gradual at-
tack. We can display the attack slope of each successive note, which indicates whether each 
note has a steep attack (high attack slope value) or gradual attack (low attack slope value).
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mirattackslope('myfile.wav')

mireventdensity: Density of notes
You can display the density of notes over time, like this:

mireventdensity('myfile.wav', 'Frame')

High values in the curve indicates moment where there is a lot of notes, low values shows mo-
ments when there is not a lot of notes.

mirpitch: Pitch height
We saw in section 2 that we can have a first simple representation of the successive notes with 
their pitch by computing the spectrogram, for instance using:

mirspectrum(a, 'Frame')

We can see some kind of music score emerging from this picture, but if we need more explicit 
information about these pitch height, we need to perform more complex operations. Hopeful-
ly, you don’t need to do these operations yourself, you can use advanced operators, like mirpitch, 
to get these advanced operations, for instance:

p = mirpitch('myfile.wav', 'Frame')

mirplayer(p)

This shows the progressive pitch height discovered throughout the audio recording.
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5.  TONALITY

mirchromagram: Pitch class profile
mirchromagram('myfile.wav')

The chromagram curve shows the distribution of energy along the 12 pitch classes.

You can also see the evolution of this distribution over time, using the 'Frame' option:

mirchromagram('myfile.wav', 'Frame')

mirkeystrength: Tonal analysis
mirkeystrength('myfile.wav')

The key strength curve shows the probability for each different key, major (in blue) and minor 
(in red). The most probable key is the one with the highest value.

You can also see the evolution of this key estimation over time, using the 'Frame' option:

mirkeystrength('myfile.wav', 'Frame')

As usual, the horizontal axis represents the time, and here the different key candidates are the 
different lines. Red colors shows the most probable keys at each particular instant.

mirkey: Tonal analysis
mirkey('myfile.wav')

This simply returns the most probable key found.

You can also see the evolution of this key estimation over time, using the 'Frame' option:

mirkey('myfile.wav', 'Frame')

mirmode: Major vs. minor
mirmode('myfile.wav')
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mirmode tries to estimate if the piece is in major, or in minor mode. A high positive value indi-
cates majorness and a high negative value indicates minorness. A value close to 0 indicates an 
ambiguity between major and minor.

You can also see the evolution of this mode estimation over time, using the 'Frame' option:

m = mirmode('myfile.wav', 'Frame')

mirplayer(m)

mirkeysom: Key map
mirkeysom('myfile.wav')

This keysom maps locates the tonality of the piece in a 2D maps where all the tonalities are re-
presented with suitable perceptive distance between them.

You can also see the evolution of this keysom estimation over time, using the 'Frame' option:

mirkeysom('myfile.wav', 'Frame')
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6 .  STRUCTURE

mirsimatrix: Similarity matrix
mirsimatrix('myfile.wav')

The similarity matrix shows the similarity between each instant of the piece of music and each 
other instant of that same piece. Time is displayed both in the horizontal and in the vertical 
axis. By default it is computed based on the spectral representation (mirspectrum).

You can also compute the similarity matrix for other representations, for instance:

c = mirchromagram('myfile.wav', 'Frame')

mirsimatrix(c)

Try both methods (the default with mirspectrum and the one with mirchromagram) and observe 
the results.

There is also a timbral feature we haven’t look at yet, called MFCC, whose actual definition is 
quite technical. One interest of it is that it is useful to show temporal evolutions in the timbral 
domain:

c = mirmfcc('myfile.wav', 'Frame')

mirsimatrix(c)

mirnovelty: Novelty curve
n = mirnovelty('myfile.wav')

mirplayer(n)

The novelty curve shows the moments in time where there is the most important contrasts. By 
default, it is based, like mirsimatrix, on mirspectrum.

You can also compute the similarity matrix for other representations, for instance:

c = mirchromagram('myfile.wav', 'Frame')
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s = mirsimatrix(c)

n = mirnovelty(s)

Try both methods (the default with mirspectrum and the one with mirchromagram) and observe 
the results.

You can then automatically highlight the peaks in the novelty curve:

p = mirpeaks(n)

mirsegment: Segmentation
Then you can segment the audio files at the position of those peaks, by writing:

s = mirsegment('myfile.wav', p)

Then play the result of this segmentation:

mirplay(s)

You can then perform any analysis you like on this segmentation, for instance:

p = mirpitch(s)

mirplay(p)
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7.  WHAT CAN I DO NOW?
Now there are plenty of different kind of analyses you can perform with all the building blocks 
you just discovered. And other tools are available as well in MIRtoolbox. More details in the 
User’s Guide.

You can also get a synthetic list of commands available in MIRtoolbox by typing:

help mirtoolbox

Each MIRtoolbox command, even all those we saw in this short tutorial, offers a large set of 
possible options. You can see more details about these command by looking at the online help 
for each command by typing, for instance:

help miraudio

The best documentation is in the User’s Guide, with explanations, figures, etc.

If you need the actual numerical values of the output of your computations, use mirgetdata:

s = mirspectrum('ragtime.wav');

mirgetdata(s)

You can also get basic statistics from your analyses, for instance:

t = mirtempo('myfile.wav', 'Frame')

mirstat(t)

You can export your analyses to text files, that you can use in other programs, such as SPSS:

t = mirtempo('myfile.wav', 'Frame')

b = mirbrightness('myfile.wav', 'Frame')

mirexport('myresults.txt', t, b)

Again, don’t forget to have a look at the extensive documentation offered in the User’s Guide.

Have fun!
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